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Part 1
Shortcut Key




Schematic Editor Keyboard Shortcuts
HELP > Schematic Capture > Schematic Editor > Keyboard Shortcuts

Key Command Ctrl-& Draw an arc{graphical annotation)
_ (spacebar) Zoam to fit Ctrl-B Draw & box({graphical annatation)
! Behavioral source Ctrl-C Copy selected abject(s) to clipboard
ct Capacitor Ctrl-F Find
ol Diade Ctrl-G Tngqle dlsplay.nf grid dcns_
£t EY—— Chrl-L Draw a line{graphical annotation)
Ctrl-m Mirror selected abject(s)
E ES0LIGe Ctrl-R Rotate selected object(s)
& Ground; e source Alt-Ctrl-R Ratate in 457 increments
H H-source Ctrl-v Paste
I Current Source Ctrl-x Cut
i JFET Ctrl-y Reda
Lt Inductor crk-Z Undo
Mt MOSFET Ctrl-3 Craw & triangle{graphical annatation)
ot Bipalar Transistor ; Taggle a text graphic's comment status
1 5 F2 Toggle visibility of the Symbal and IP Browser pane.
R Resistor . X
- ; F3 Taggle visibility of the Symbel Properties pane.
S: jvoltageitontiolied iSwiich F4 Toggle visibility of the output consale.
T Place Text F5 Run the simulation.
vt oltagelSouras 1] Repeated depressions of the key cycles through different versions of the symbol.
w Start a wire 2] Repeated depressions of 'G' cycles through different versions of the ground
Y Piezoelectric Crystal symbol and then G-source symbols.
zi MESFET 31 The period key, '.', is accepted as a synonym for 'T".
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Symbol Editor and Waveform Viewer Keyboard Shortcuts

HELP > Waveform Viewer > Keyboard Shortcuts / HELP > Schematic Capture > Symbol Editor > Keyboard Shortcuts

Waveform Viewer Keyboard Shortcuts

Symbol Editor Keyboard Shortcuts

** Hold down ALT key (after simulation is ran and with an active waveform viewer)

Click on a node for voltage or device for current — Can prevent accidentally move wire or device
Click on a node and drag to another node — Can measure differentiate voltage, i.e. V(N0O01,N002)

Key Command Key Command
Delete Delete attached cursor if pointing to a readout or delete selected plot labels Ctrl-A Draw an arc defined by three points
F Zoom to fit(all panes) Shift-Ctrl-a Draw an arc defined by four paints
F4 Toggle visiblity of the console display Ctrl-B Drawi a bax(or & box for an image)
F5 Rerun the simulation Cirl-C Copy selection(s) to clipboard
_ Reload Plot configuration file E Draw an Ellipse
< Move attached cursor left Ctrl-F Find
s Mowe attached cursor right Ctrl-L Draw a line
1 Move attached cursor to next step } B tep Ctrl-M Mirrar selected objects
1 Move attached cursor to previous step ) P Place a pin
Ctrl-A Add a trace Ctrl-R Rotate selected objects
Ctrl-C Copy T Place a text attribute
Ctrl-D Delete a plotting pane Ctrl-v Paste
Ctrl-F Find Ctrl-x Cut
Ctrl-G Turn Grid OnjOff Ctrl-v Redo
Cerl-v Paste Ctrl-Z Undo
Ctrl-p Print Ctrl-3 Draw a triangle
Chrl-W Add & pletting pane F3 Taggle visibility of the Properties pane.
Ctrl-X Cut
Crl-Y Redo
Ctrl-Z Undag

** Hold down SHIFT key to probe current — invert the sign of a current quantity
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Waveform Viewer Functions and Keywords (.func, .meas)
HELP > Waveform Viewer > Waveform Expressions

The teligeadng hindans, Canszrs, and kaviords are recognized 1N areszlons ot wivetorm data.

Wavefarn Viewer Functisns amnd Keywords

Doccription FRFCY -~ Lx
|x| Asclule vabas of x TROQUENCY R X
cos Tx Ineerze cosirg ot 2 : - ELFL
Imuzesz byperhaliz seans of & xY w raisend L Lhe
Trrvwre cosine ol & g = Tlzed Bo the nedesT e value o v
Thvarse Fpertbails 2oshhe of Unbigsed experant ot | X7 st vakiz e x s  the g v
o Imaqrary 1A o PR
Triverse lipper Iregiviany .o L £021754E7%-15 Couleny
Tverse tange = rended to nearest Inkeger re(x) Heal part af
warrabe banpeet af « LR R Rual penl al =
sin~x e s Lovis % TR o KN [1earest | teger
Tverse hyperbellc she of = Cuig It 15 Nk 3 unier, ctheraise zern « e b the neast mreger
tan lx I tangrr of R ¥ 1 SE
[y s Langeril of o Zwos el Gemsed P livn of Joe sl Kired el x I
Troerze e et o Fis=arcier Zessel ncdon o the Thes knd at s el sinx
e 1 W ot Dl furiziom o Lne (s, kin al i
iz ok reel of % 1380840223 174 Jx
s rounded L3 b redies Irsene r pama funcho of &
cosx . Mualy ileriresdia e lue o 5y, o < an x angrre of
g belic cusives of Toge x Natural qarithm ot = 1 gperboiz: Lerigen. o
Tomrgent of = loge x Kiatural kganthm af Craup delay ot =
" logiex Logarilinr of & i bese 160 wrrrpelate the Fakls puen as 2147, w0y 2k pos e
Haturai Icoaittm o (4 L3 Sinzai
Lesganthim af «in base 4 Croup delay
LG AL - 1oz
TxT Azclute vale of 3 Dulsgen porl of &
“ammin of x and ¢ xwQ7x-0
eX 0y s i e Lds EEN R ]
10% AV U TITEEd 10 be 1t a rumbe Zerz enchen Deresed Crscdion f L seeveed kind = s
Mzl 3 rimm of x ared ¢ FArst ander Baxszel hnction of e second bnd ot
s Taunded domi b MearesT Imee LR it irisgnilude Y et Dt Curcdior of L secvnd kind 5.

4 En enmytice AT, PR Sy 15 STAF[TL ThE MEARnGg is ATARF RS RS (7)),
<= simulation variable
<= important constant
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Function and Operators for Behavioral V and | Sources
HELP > Simulator > Device Reference > B. Behavioral Sources

Functions
Opcrators grouped in der af pr of
Name Description ey . .
L B L) vty e T - T
akeie] |x| » akmchr sl of « il Canme 2 Loird |2?% %;:a" Lon
| ekl €Oos X a1 s ol & ) 0. %> 5, ebe L. | [
“’“j‘-:ij 5;:"0“‘“ fa ot s I |zt e of v, v and 7 )
arashi] a7 Rporbois crene of 7 S
wial sin~!x L e T o "'I log, x Helural kagan L ol « B True IF sareszlan o the ek Is qreater hain the expresskon on e riaht.
S S gz 110gc X Altermie st for i} . Irur F mesaan ot (e 15 ke shan the eaperssen ot right.
kel i gt afsy 0810 X T:‘”‘ "'l"' o b= Towe il awarensian o e lel.is greale i oo eyl e expsson an de il
g _ " A 12 Lrkslar ol & o - e . -
wlanix) tan~1 x e Lanuertl of & nil'ﬂ:r.':'i TR “; = True P estanszlan o Ehe eb21s sz Ta of e0al the exprazalen on e At
TFEE o b ey A xY i + Aukdiion
atamiy o) —our quaadrant anc rgonk ef s = 'K’ o x| .
; i [Py x| sl [} .
ulantea] e bpprrbuiic: Larigenn. SRS Sani ot SUELEtin
L) Lirs= 5, elzed - Kandrm nuenker frm 0. o 1. drpensing an she mtogar vl af v , Mullishabon
reliy) Inteyar el er gresere than, £ INbanyakidan DEtEEn o MBS |5 INedr 1ar ner-integer & z o
Loy oS X Fusimal s anix) S sreafy ! BB
ok e toil - cohg o 3 siriliix] g bulie: s of « . . . . a
J:,,,I.,} ‘ dx/dtime ,"L,,::,I:N ?:n; 77 s&m:x R LA B lel hand site o saser o vight bered side, Same s '
delaglsy, # delayed by ¢ tak Interpilabs % fem th laak 1 babls guen as 2 sot af o af corstant -
. Fow b fal pang coprsan.
dekrin gt  dedayod fay v, bt share e mare than 7 by Eabod,.. ) . waEiLes. 0 rar ek the faleang i,
Mingrgey | ¥ TR g atach £ semgranealy car 1 apech a1 7 38 ot tenfs) Ay e (cf =
LEn IWerie O LaLIerE seiles Larihi) rppoerbiics Laigern o7
) e ~tathew e xbaurded by y which Easwiptaticaly szorts by aponach at -2 a3 a first
: ! ; v inveine vl Lausnl seriss
izl Dubeger evpaal loon b b x
fepadns |/ x? + ST - 2 . L .
Ty lime: ntegral o 3 wrh naal sondton ef  rest ehon e Available Function in B source not listed
fx dtime + y . Trunc(x) ; floor(x) ; int(x) : rounded down integer

Rint(x) ; round(x) : rounded to nearest integer
. Ceil(x) : rounded up integer

Ustep(x) :x>0?1:0

Uramp(x) :x >0?x:0

— Ctrl-Shift-V : Paste Netlist as Graphical Symbols on Schematic
ALT-Mousewheel — Delimited numbers
Netlist (Ctrl-C to Copy)  Paste with Ctrl-Shift-V Paste with Ctrl-V
* C:\QspiceKSKelvin\01l T MNO1 NO1 NO2 ND2
V1 NO1 0 1 V1 ?‘1 R _|C VINO101
R1 NO1 NO2 1K ra} K Sk Lip R1 NO1 NO2 1K
R2 NO2 0 1K ND2 R2 NO2 0 1K
Cl NO2 O 1]‘1 Revision History
.end 01/13/2024 You can now paste fragments of a Cl N02 0 ll.f
netlist copied to the clipboard as graphical
symbols on a schematic by typing shift-control-V.
e ALT-Mousewheel -
« Delimited numbers in in__J|__out
schematic or netlist \"2! 1” R1
. Hi?hlight number by H <
selecting its (double click AC1 K e
in sche(;natic), key pressing
ALT and rotate
.ac dec 100 1 100K
mousewheel “plot V(out)
Hide Symbol Pins
* Hide Symbol Pins — i
« If you directly type a net vdd o vdd -
name into the Net field, V1 e Vi
the corresponding pin in o
the symbol will be set to 1 sk
invisible and connected to Pekrmadty
that net name i
* This zlalflovxas userls tok - 1 e ) g
simplify the outlook of the in—[w- <5 v - w .
schematic out n out i
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Drag a Symbol into Schematic (Two Methods)

Method 1: Drag from File Explorer Method 2 : Drag from Symbol & IP Browser
[1] Go to View > Symbol & IP Browser [or use the shortcut F2].

[1] Open the symbol folder using File Explorer [2] Select the folder containing the symbol files (.qsym).

[2] Drag the symbol files (.qsym) into the schematic

) = 01 User Guide and Script »

02 General Reference Guide

1 ShortCut Key »

[3] If a folder with .qsym files is selected, a new tree path will be displayed.
[4] Drag the symbol from the Symbol & IP Browser into the schematic.

@ Qorvo QSPICE™ - Untitied - u] s
File Edit View Help

Jidd 08 Hu@

01 Entry User Guide R Name Date modified Symbol & 1P Browser - %
= > = 2
Ui{uenheral .F‘sererded.l\ce |.3u.oe @ symExasym 4/30/2024 10:59 PM ¢ - .«'[c1}3550-1nz-mpo| e "
archive (can delete) . . Q. ACT: 400V Input, e
¥ [2] drag into schematic 9. ACT43950-400 Inpust, Battery) XI
1 ShortCut Key — i 3 JFET S mE
Qo SPICE™ - Untitled # £ Moduley
Drag 2 Symbol @ Corn QSPICE™ - Untitle i y X

= Fle B
2 Hierarchical and Subckt 5

3 Schematic Viewer

View  Help

Jided $ D Hoe®

4 Waveform Viewer $
5 Simulation Technigue
Func

03 Command Reference Guid

D4 Device Reference Guide

05 Cspice KSKelvin Demo

)

SymEXx

& SiC Schottioy

.QSPSCE

Part 2
Hierarchical and Sub-
circuit
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Hierarchical and Sub-circuit : Comparison
Qspice : parent - hierarchical and subckt.qsch | +RdividerH.qsch

e Hierarchical and Sub-circuit

Hierarchical can

1 1 i
* They are similar and both + & 1 entelr schematic
support by .gsym symbol, but V1 m—H1 m-s1 | 5 Enter Schematic
two different concepts = 4 4 71 Add New Attribute
- . 1
* Hierarchical ¥1 = X2 O Add Port 1
+  Call a child schematic (.gsch) for +Rdhderd +RdhiderSUB

swmu\vatlon Jran 1 E Hide Symbaol Properties
Circuit in child schematic (.gsch) pJnt v 51] O Hi Helo File P
+  Waveform viewer can probe e ( < D e
simulation result in daughter -plot V(H1) @l Netist Subcircuit

Orientation P

schematic (7) Disable Block
*  Sub-circuit (.subckt) e - o e .
«  Call a sub-circuit (.subckt) for pplaion S)_/mbol Eropertles of Application Symbol Properties of
simulation Y 1P Hierarchical 2410 # Subckt
Circuit in .subckt model Basics Basics
: Symbel Type - Fpmbal Typs X
° Wavefo_rm vwewe( cannot probe Description Hierarchical no Symbol Type  Dusciption Example of .subckt
simulation result in subckt Allow ShodedPins False Subckt with Symbol Type as X AfawShanedPms  Faise embed into symbol
Result is calculated and stored, just not Lieary Fila Uit Eh subekt+RdividerSUB.
able to directly probe it. String Atiibutes =l Strie) Altrcins
» In Qspice, .subckt syntax can Nams x Name e ) )
embed into gsym in I\'brary file Tt attnbuse +Rawderd 1St attribute is .qsch name Tst attributs -RdwigessUB 15t attribute is
R ! Pin Nets i .subckt name
properties (i.e. can share a single Nar Nat Name vis. N
T T 1 NO1 * NOT
.gsym file for simulation) i ; i
m H1 m s
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Hierarchical and Sub-circuit : Comparison
Qspice : parent - hierarchical and subckt (dual hierarchical/subckt).qsch

» Hierarchical and Sub-circuit
¢ In netlist, both Hierarchical
and Sub-circuit call .subckt
syntax

* Hierarchical
*  Child schematic is a .subckt in
Partent netlist
Symbol calls this child schematic
name

e Sub-circuit (.subckt)
*  Each symbol calls an individual
subckt by naming its by add prefix
as Xnnne<subckt name>

Hierarchical Block

1

+ +
1 i1 mHz2
X1

<L %2
+RdhviderH +RdividerH
Jdran 1
Sub-Circuit (.subckt)
_ - -
+ | +
@"*‘1 Q—An mi—ﬂ]
i ; .
~ X1 w X2
+RdividersLIB +RidsddersSLIB

* C:\QspiceKSKelvin\0l User Guide and Script\02
V1 NO1 O 1

X1 W01 0 Hl +RdividerH

X2 NO1 0 H2 +RdividerH

-subckt +RdividerH + - m

Rl +m 1K

R2m - 1K subckt for X1 and X2
.ends +RdividerH UBEiiD e

<child schematic name>

-tran 1
-end

¥ C:\QepicaFSEalvini0l Usar Guids and ScripthD2
W1 NDL D 1
-subckt Hl*+RdividarSlE + - m

El + m 1E

RF2 m - 1K

.ends +Rdividex .subckt for X1

X1 ND1 D Hl Xle+EBdividerSUE s .

.subckt H2e+RdividezSUE + - @ X1-<subckt name>
Rl + m 1K

B2 m - 1E

.ends +Rdivider

H2 N0l 0 S1 H2++RdividerSUE me:
.tranm 1

c=nd

.subckt for X2
X2+ <subckt name>

< >
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Hierarchical and Sub-circuit :
Qspice : parent-PassParamHierarchical.gsch | +VdividerH1.qsch

» Parameter Passing

* Hierarchical and Sub-circuit
works in same way

* As default, .subckt or child
schematic load its .param

* In parent schematic, if string
attribute in symbol contains
parameters, they will override
.param within .subckt or child
schematic

Symbal Preperts » X

Vi
1

+VdividerH1 = @
tran 1

+\WidividerH1.gsch

RT*(1-atia)

RT*rati

Jparam RT=10K
Jparam ratio=0.5
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Qspice : parent-PassGlobalParam.qsch | +VdividerH1.gsch | +VdividerH2.qsch

 .param from Parent

* Global .param passing
from parent into a child
schematic depends
whether this child
schematic has the
parameter defined

* If no such parameter is
defined in child schematic,
global .param override

* If parameter is defined in
child, global .param is
ignored. Only string
attribute in symbol has
ability to override child
schematic defined
parameter

| |
+ +

m—H1 m—H2

Y1
=
i

dran 1

X1 X2
+vidividarH1 +WdividerH2
.param in parent schematic

(.param ratio=0.8|

No effect

<n1

< BT*[1-rati)
L *m
2R

]’ B

+ydividerH] gsch

T*ratio
param RT= 108
param ratio=0.5

th

+¥divigerH.gach

Lay

>RT‘[1-rabn]
]}*’55.
~R2

>
\‘ RT*r@l0  param RT=10K

B No ratio is defined in
+VdividerH2.gsch
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Three Way to Define Default Parameters in .subckt
Qspice : parent-PassParamSubckt.qsch | +VdividerS.txt

» Three Way to Define Default Parameters in .subckt

V1 +
A 51 2
X1 N2 X3
+VDIVIDERS1 +VDIVIDERS2 +VDIVIDERS3
tran 1 / params: RT=10K ratio=0.2  RT=10K ratio=0.8 \
.subckt +VdividerS1 + - m .subckt +VdividerS2 + - m params: RT=10K ratio=0.5 .subckt +VdividerS3 + - m RT=10K ratio=0.5
R1 + m RT*(1-ratio) R1 + m RT*(1-ratio) R1 + m RT*(1-ratio)
R2 m - RT*ratio R2 m - RT*ratio R2 m - RT*ratio
.param RT=10K .ends +VdividerS2 .ends +VdividerS3
.param ratio=0.5
.ends +VdividerS1 \

For this version, if removes .param lines, param can be added in symbol in string attribute
Right Click on symbol > Add New Attribute

kskelvin.net 16

Three Type of Sub-Circuit (.subckt) Symbol (.qsym)
Qspice : parent - 3 type subckt symbol.gsch

Embedded SUBCKT Link to Librar

C ?/ No Embed or Link
[Easy to share, just one .qsym] [Recommend for complex .subckt] [For universal symbol]

Symbol Properties - Symbel Properties - Symbal Properties -

| Application Application Application

sl 3. # K I Gt G.#

Bl Basics subckt is in library  E Basics Library isin library =~ = Basics Nothing is in library
Syinbal bype *  file properties Symbol Type X file properties Symbol Type % file properties
Description Description Description
Allow Shored Pins False Allow Shorted Pins False Allow Shorted Pins False
Library File | subekt +RidwidarH1 + - minR... Library File subckt_Ebrary b Library File

= Sinng Altributes = String Attribules 1 String Attnbutes
Text Order nvis. Content Text Order Inwvis. Content Text Order Inwvis, Content

Mame: x1 Mame: X2 MName: x3
13t atiribute +ROMVIDERHT nt mibane JAONDERHE 15t atiribute +RDIVIDERH3
| subckt_library.tt E3 I
W1 e i il 1 | subckt +RdividerH2 + - m
2 Rl + m 1K
1 m m m 3 RZm - 2K
o = = 4 .ends +RdividerH2
v X1 v X2 X3 : -
+RDIVIDERH1  +RDIVIDERH2  +RDIVIDERH3 B =vhokt iRdividersd + - m
Jib subckt_library.txt QR =t R
Aran 1 4 U e e
Library is added by .lib statement sNcS TRoerRd
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Hierarchical and Sub-circuit Sub-Topics

e Part 2A : Hierarchical Block

* Create hierarchical block from child to parent or parent to child schematic
 Create symbol for hierarchical block
+ Get .subckt from hierarchical block to convert into an embedded subckt symbol

Part 2B : Symbol for Subckt [Embedded Subckt]
Part 2C : Symbol for Subckt [Link to Library]
Part 2D : Convert MOSFET M to subckt Symbol

* Demonstrate how to convert a MOSFET M symbol into subckt to save effort in creating a
MOSFET symbol for .subckt MOSFET model from 31 party vendor

Part 2E : Bus and Hierarchical Block

kskelvin.net 18



Part 2A
Hierarchical Block

Hierarchical Block : From Child to Parent
Qspice : filter_circuit.qsch | filter_circuit_app.gsch

Method #1
[3] Create a new schematic which will call to use hierarchical

[1] Create a child schematic (.qsch) with circuit and net label [4] Edit > Draw Hierarchical Entry

[2] Right click on net label and select “This is a Port”

Method #2
® QsPICE™ - filter_circuitgsch [31 In child schematic, Right click > Open Parent Schematic
Fle Edit View Help This will automatically create a parent schematic contains
JGd 4 2B a9 @ hierarchical symbol, with all Port automatically created
Ll ® QsPICE™ - filter_circuit_app.gsch
fout e
587n 'f.“ Highlight Net d ..P Dm- - TI i
NI Edit this Net Name i }r,w;'mre ‘:‘I
234p 234p 3 Invert OverBar e ‘-ace .o.ur'G e
NT Flace a Net Name N
hia 163 fory @ Piace Text{SPICE directive) T
i 4 &L Place a Bus Tap
Add/Edit Description Draw Graphical Annotation 4 x 1
5l Draw Hierarchical Entry Cirl+H
> unie « filter_circuit_app_X1
< Rede Ctri+Y
& Cut Ctri+X
kskelvin.net 20

Hierarchical Block : From Child to Parent
Qspice : filter_circuit.qsch | filter_circuit_app.gsch

[5] Change component text (1<t attribute) to match child
schematic name

[6] Right click hierarchy component and “Add Port”

[7]1 Name ports as port name defined in child schematic
[8] Right click hierarchy component and “Enter Schematic” A completed example
should open child schematic o I

1in out y1 OU Rt
X]. gAm M 550

filter circuit .ac dec 100 1Meg 100Meg
= plot V(out)

Enter Schematic

T | Add New Attribute
0O Add Port
Qrientation »
“®> Show Symbol Properties
@ Netlist Subcircuit

'T ! Disable Block

kskelvin.net 21



Hierarchical Block : From Parent to Child

[1] Right click > Draw Hierarchical Entry

[2] Rename component text (15t attribute) to child schematic name

** Child schematic will be created later

[3] Right click within Hierarchical Block > Add Port

[4] Right click > Enter Schematic, it will create a child .qsch

® Corvo GSPICE™ - parent Adivider.qsch
Fle Edt Vew Hep

Dbk a8 e

X1
+Rdivider

5L Erter Schematic

|71 ca New Arribute

S—m—— O acdpon

Crantation
W Show Symbol Properties:
Wb rerarchy Heip File Page
B etiet Subcro
(D) Dable Block

[5] Create circuit in child schematic

® Qoo QSACE™ - +Rowidergsch
File Edt View Help

dgE 408 S8®

10K

§R2
10K

-]
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Hierarchical Block : Create Symbol (.qsym) for Hierarchical
Qspice : parent_Rdivider.gsch | +Rdivider.qsym
[1] In a parent schematic which contains a hierarchical block [7] Save this symbol (.qsym) in the same directory as the
[2] Hold Shift, draw a selection box to select Hierarchical hierarchical schematic (.gsch)
[3] Press Ctrl-C to copy
[4] File > New > New Symbol How to use .qsym with .qsch
[5] In New Symbol window, Press Ctrl-V to paste [8] To place this symbol in the schematic window, drag it from
[6] A symbol for a hierarchical block has been created, and now you the File Explorer and drop it into the schematic window
have the option to edit this symbol. However, please keep in mind that
the "Symbol Type" field must be left blank for a hierarchical symbol -
@ {8 Coevo CSPICE™ - +Rdividergsym = o . - P “ 02 General Reference Guide * 2 Hieranchical and Subcks » 24 Hiesarchical Block
Fie Edi Vew  Help Fie ESt Vi Haip 1 ShonCut Key - i
_.-]_"!:_“._'!.."‘._9_ "i' v ® ddd 4 al“ Y 2 Mierarchical and Subckt v .
. . . ;! ® 4 ? it 2 Basic Explanation ® t::::::mm i
':W;'i“;" 28 Hierarchical Block @ +Rawiderqzpm VR0
‘f‘Rlelder X'l. . "I;:;;- blank 28 Symibol for fulxn uv. gmwr_:.r:.mcr.mwI 2
o 2C Syl for Subcid [Link ||||:er:|:|ln:._::1 ..|
i +Rdivider = T = Rem— -
Sting At IF Diesvice with model Fie Bdt View Fp
Iy == i nlie ¥ Schematic Viewer Qg b a8
- . o  Simulaien Technique X1 Drag to schematic
o sunc +Rdliwider e
m] 1 Z 03 Command Reference Gulds T
: Brme——
06 DL KSKishin Deme | m
— 07 Qe Fonum &
q 08 Other semedators -
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Create Hierarchical Symbol (.qsym) for Hierarchical : Method #1

Qspice : RC_sch.qsym ; RC_sch.qsch

[2] Create a symbol

[1] Draw a schematic .
This example has
»  Two ports : in and out .

R1
'r'\v_f 11-’ Tout
R €1

lin |

N

1st attribute : [schematic name]

» Symbol Type : Blank (nothing)

Don't assign a X (X for subckt),
hierarchical entry no symbol type

Pin name needs to match schematic ports
(order not important)
Use Text to assign

ame : X1

Symivel Properte

i
.param R=1K
.param Fcutoff=1K

fc = 1/2/pi/R/C

'
—

“out

Application
HIE T ¥

Remark :
Major Different for Symbol to call
schematic (hierarchical entry) and subckt
*  To call schematic (hierarchical entry)

*  Symbol Type: Blank

*  Name: X1

e Tstattribute : schematic name
e To call subckt

*  Symbol Type: X

¢ Name: X1

e Tstattribute : subckt name

Al Shrte
Ly Fils

Falue

Jparam C=1/2/pi/R/Fcutoff

U_
A

et Rsrarchesl
spacii SPIGE devce

kskelvin.net
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Create Hierarchical Symbol (.qsym) for Hierarchical : Method #2

Qspice : RC_sch.qsym ; RC_sch.qsch

[1] Draw a schematic

This example has

*  Two ports : inand out

*  Right click these nets and select
"This is a port” (only these ports will
auto generate hierarchical entry)

[2] Right Click > Open Parent Schematic

It will ask to automatically generate a

parent schematic

R1

R

.param R=1K
.param Fcutoff=1K

[3] Copy hierarchical block in parent with Ctrl-C

) OSMCE™ - Raren R seheneh
n out
X1
RC_sch|

[4] File > New > New Symbol, paste with Ctrl-V
** Symbol Type : Blank (nothing)

Don't assign a X (X for subckt), hierarchical no symbol type.

If you re-open a hierarchical symbol, please pay attention
in here as it may auto assign an X into Symbol Type

[5] Save as a .qsym symbol

Remark :
Major Different for Symbol to call
schematic (hierarchical entry) and
subckt
e To call schematic (hierarchical)
*  Symbol Type : Blank

. Name : X1

. 1st attribute : schematic

name

*  To call subckt

+  Symbol Type : X
*  Name: X1

. Tst attribute : subckt name

Qspice HELP Reference

Help > Schematic Capture > Schematic

Hierarchy

kskelvin.net
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Create Subckt Symbol (.gsym) from Hierarchical Circuit (.qsch)

[Step 1 to 4]

[1] In hierarchical schematic
Right Click > Open Parent Schematic
It will generate a .gsch with prefix Parent.

L1
E———— o]
_Lct sem e

I234p

NT Place a Net Name

@ Place Tet(SPICE direcive)
L | Place 2 Bus Tap
Draw Graphical Anmatation ’
i o Gre CuleG
Mark Text Anchor Points
Mide Raforence Designator:
Gl Draw Hurarchica) Entry CrieH
1Ly Cipen Parent Schematic

[2] In Parent Schematic, verify/change Pin
Order if a particular pin name order you
need for .subckt

Edit Pin Labsl

an out PinOrcer ¥|  Pnomero

Invert OverBar

Orienation 3

filter_circuit | @ e o

X1

filter_c

[3] Right Click on Hierarchical Symbol, select
Netlist Subcircuit
[4] select all and copy .subckt netlist with Ctrl-C

51| Enter Schematic

T Add New Attribute
O Add Port
Orientation L3
= Show Symbal Properties
&8 Hierarchy Help File Page
S Netlist Subgrcuit
) Disable Block

® Qorvo QSPICE™ - filter_circuit
File Edit View Help

BEEE" BN

.subckt filter circuit in out

Cl in 0 234p

Ll in out 587n

C2 out 0 234p

.ends filter circuit
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Create Subckt Symbol (.gsym) from Hierarchical Circuit (.qsch)

[Step 5 to 6]

[5] Ctrl-V to paste the text into a schematic
(or a blank symbol) to invoke the 3rd party
import routine

@ Autogenerate Symbol s

Shall a symibol be generated for the subcirost "FILTER_CIRCUIT® below?

Jsubckt filter_circult in out
C1in0 Z34p

L1 in out 587n

€2 ot 0 234p

<ends filter_ircuit

[]ncude Entire File Cancel NO

[6] A subckt symbol is generated with
embedded .subckt which contain the circuitry
that you can use in any schematic in any
directory

Symbal Properties - X
X1 Appical b
a i
In Sl G
Basics
FILTER_CIRCUIT g L
= Deseription Machine generate
Allow Shorted . False
t Library File |- subscha filer_circu...
OH Siring Altributes
Text Ordes Invis. Cantent
Name: X1
Tat altribute FILTER_CIRCLAT
= Pin Nets

kskelvin.net
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Part 2B
Symbol for Subckt
[Embedded Subckt]

Symbol for Subckt [Embedded Subckt]

[1] Assume user has a sub-circuit .subckt in text format library file
[2] Use a text editor to open library file, copy text for sub-circuit
[3] In Qspice schematic, paste the text (Ctrl-V)

@

File Edit View Help
JSd $-208 Gv@®
Symbol & IP Browser  w X |

|

= Symbols & IP

# & Builtin Symbols(Na Shall & symbel be generated for the subcircst "RFSI0° below?
# i Behavioral _ _
<1 i Qorvo® LSUBCKT 53012 3
FET M1 9788 MM L=100u W=100u
Hia JFE -MODEL MM NMOS LEVEL=1 IS=1e-32 VTD=3.87932 LAMBDA=0.00393780 KP=7.0501%
H-i SiC FET RS 830.073836

i | D131 MD

il SIC Schottior -MODEL MD D 15=9.70956¢-10 RS=0.0137423 N=1.31938 BV=300 BV=0.00025 EG=1 X
RDS 3 1 de+04
RD 9 10.0001
RG 27977071
D2 4 5 MD1
MODEL MDL D 1S=1e-32 N=50 C}0=7.50724e-10 V1=0.801667 M=0.67327 FC=1e-08
D3 0 5 MD2
-MODEL MDZ D IS=1e-10 N=0.401518 RS=3e-06
RL5101

T wiclude Entire File Cancel No

I

** |f sub-circuit consist of other .subckt,
click this block to include entire file

[4] Rename pins by referring to description in model file
(this is optional step)

| | @ Autogenerate Symbol ¥ |

D IRF530 G

X1

S

o J
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Symbol for Subckt [Embedded Subckt]

[5] File > New > New Symbol to open a Symbol Window
[6] In schematic, Ctrl-C to copy Component X1
[7] Goto Symbol Window, Ctrl-V to paste component

-]

Bt View Hew

METNET- RN ]

X1
D IRF330

S

X1
IRF530 G

[8] Delete the box, rearrange pins location, and draw the symbol
[9] Save into a .qsym symbol format

@ QsPICE™ - irf530.0sym

File Edit View Help
Jigdd %28 8@
T <

X1
IRF530-
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Symbol for Subckt [Embedded Subckt]

[10] In Schematic, Symbol & IP Browser, Right Click to "Add a symbol directory” A completed example
[11] Drag created component to schematic

[12] ** text library is no longer required as .subckt is integrated into symbol shoniborians

(You can also directly drag a .qsym symbol file from window explorer to schematic) i At 5

Sywied & P limse W X
@ QsPICE™ - Untitled
File Edit View Help
JSd 08 fe@

Symbol & IP Browser w X

<0 ~
delinV1050.1

42 : 3 s : i Total I;llpuud time: 0.0045291~
= JW i Dl X1 "
109 | Place o G+ L1IRF530+ ¢ 2
-l Bwllli 8 ! | Wb w o Sieton | Pt Froces
7 Behay =
= Qorvg
1 JFE

i Sl(j
H-Sr Si Add a symbaol directory
1

o Symbols & IP
2 Builin Symbolsiia X 1
& Behavioral D
& Qorvo®
o ' IRF530
-4 SIC FET S
¥ i SIC Schottky
= (spiceFiles 1
9 irfS30-Machine

-
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Symbol for Subckt [Embedded Subckt] : Label with Text
Qspice : irf530 with text.gsym

* Text can be used in label

» For example, instead of changing net - e
name, you can | ‘ S EMay
* Right click > Text x I e s
* Right click on text > Select “Comment” N ——1 f.'lf:;"?.’.'u' Jsumext
+  Text not comment will become valid item in netlist i
» (Can change font size and color ] i <.::’r:. B
 Be careful 1 attribute is device name (e.q. | I RF530 s 13

IRF530 in example), and doesn't comment it haman »
- . " . | A CirivA | » . N Pin Narimas, Mat
[ [ U L 5
] I 5 all G
y al Edit this Text 1= J * s - i s
3 | Invert OverBar =+=| Line Cirl+l
- - . . O Pin [
8A | Invert Case al
Font size » = <\ | Triangle Cii+d
A Tigzag z
- Orientation » -l =iy
Order » = B
Color Capy Symbol fo Clipaoard

. Comment
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** Procedure to Create embedded SUBCKT symbol from Hierarchy : Method #1
Qspice : RC_sch.qsch

Right click on schematic > Open Parent Schematic
his will auto generate a Parent hierarchical block
In .suckt netlist, Ctrl-A to select all and Ctrl-C to copy

[1] Draw a schematic (hierarchy) t]
]
] Return to schematic, Ctrl-V to paste netlist and auto generate a symbol
-t
]
]

L

This example has R

*  Two ports :in and 3
(for subckt 1/O port, right click net [4
name, set "This is a Port”)

*  Two input params : R and Fcutoff 5
(comment input parameter, we will [
add it from symbol later)

his is a symbol with embedded .subckt
Click on this symbol, Ctrl-C to copy it
6] File > New > New Symbol, Ctrl-V to paste symbol in Symbol Viewer

® Qorvo QSPICE™ - ParentAC-Fil it

e L E™ aren it h

*  One calculated parameter : C h i X2 Application
Fie Edit View Hep S T >
Jod 48 Se® In

; Input parameters
.param R=1K X1 RC-FILTER

Machine generated symb
Faise

RC-Filter | subckt B Fiterin cutnd
.param Fcutoff=1K
para cutoff=1 out e
3£ Highlight Net (4] e
R1 (et n ou
il A NI Edit this Net Name i
—I i out a  Invert OverBar Enter Schematic o
\ This is a Port EI ::::1 bl
c £ :"":“’I ; P I.su.bl:lct RC-Filter in out
l w Symbiot Properties .
= oot B3

; calculated parameters 2l D eleulnted paremeters

. T ; C=1/2/pi/R/Foutcfs
.param C=1/2/pi/R/Fcutoff _ e Ro-Falter
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** Procedure to Create embedded SUBCKT symbol from Hierarchy : Method #1
Qspice : RC_sch.qsch

[7] In Symbol Viewer, re-arrange symbol layout as you want [9] Now, you can use this symbol for simulation
[8] To add input parameter R and Fcutoff, type “T" to enter
new attribute. In this example, two attributes are added, and S e
with arrow brackets <>. This syntax allows only to change ddd b S s e e
value when this symbol is called X3
© Qoo QSPCE™ - it o= . RC-FILTER
Fie Edt View Help In 1 ou Ut
i p08 58 V1 )
. Syeetul Freparties - t AT "
S & i o B R TAC1
X1, ... EE R=1K
Smboite Feutoff=1K
' RC'FI LIER « - .ac dec 100 10 10K
SO .plot V(out)

i

nouk
(R=<1k>
Feutoff=<1k>

Technique if hierarchy circuit needs update

It is not requires to re-draw the symbol. When hierarchy is
updated, re-preform step [1] to [4]. Right click new auto
generated symbol to show symbol properties. Click on .subkct
in library file, Ctrl-A to select all, Ctrl-C to copy it.

Open symbol .qsym, replace Library File with this new
embedded .subckt line.

61
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** Procedure to Create embedded SUBCKT symbol from Hierarchy : Method #2
Qspice : RC_Params.qsym | RC_sch.qsch

** This method was used before Qspice [3 : Method#1] Convert netlist to subckt
new feature added, for reference ONLY [2] View > Netlist, copy this netlist « First line add .subckt
* RCis NAME of subckt determined by user
[1] Draw a schematic (hierarchy) ® asPicE™ - Re.cir » Follow with ports (net) :
This example has Fle Edit View Help * Follow with params : R=1K Fcutoff=1K
*  Two ports :in and JiGe & a0 H6® * Remove .param R=1K and .param Fcutoff=1K
*  Two input params : R and Fcutoff * C:\QspiceKSKelvin\0l User G * Last line add .ends RC
+  One calculated parameter : C oo s
.param R=1K This is the finished version
.param Fcutoff=1K
.param C=1/2/pi/R/Fcutoff .subckt RC params: R=1K Fcutoff=1K
R1 l"“d R1inout R
in F—N out Clout0C
R - _LC] .param C=1/2/pi/R/Fcutoff
.ends RC
Tc
v Subcircuit Definition Copy and paste .subckt script to schematic, then

. follow standard symbol creation procedure for
= tenc: Jsubckt MAME N1 N2 N3 ...
-param IP'—:_ IKﬁ: Sl su © embedded SUBCKT symbol creation
param Fcutoff=1K
X1
fc = 1/2/pifR/C .ends NAME ! -
in out

Jparam C=1/2/pi/R/Fcutoff

RC
params: R=1K Foutoff=1K
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** Procedure to Create embedded SUBCKT symbol from Hierarchy : Method #2
Qspice : RC_noParams.qsym

[3 : Method#2] Convert netlist to subckt [4 - Method#2] Add input param into symbol

. 'First line add subckt »  Two input params : R=1K and Fcutoff=1K
RC is NAME of subckt determined by user : Tyrje T (;rzl?ght Click > Text, input

Follow with ports (net) : . Feutoff=1K

Remove param R=1K and .param Feutoff=1K +  This will create 2"d and 3™ attribute in

Last line add .ends RC String Attributes, where you can select to
visible or not in symbol

This is the finished version

Svincd Progertses

.subckt RC Agplication
R1in out R # X 1 :

Clout0C N ] e S

param C=1/2/pi/R/Fcutoff

.ends RC

in + ou
Copy and paste .subckt script to schematic, then 1 )

follow standard symbol creation procedure for
embedded SUBCKT symbol creation

RC
R=IK
Fcutoff=1K
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Autogenerate Symbol Pin Assignment
Qspice : Autogenerate Symbol Pin Assignment.qgsch

.subckt Block01 1
.ends Block01

3 .} i %4
%1 L X3 : Kt Block
BLOCKAL ELOCKDE 1 BLOCKO3 2 2 BLOCKGS o  -subcktBlock02 12
.ends Block02
1 i e i
2 .subckt Block03 12 3
i 4 4 L .ends Block03
x5 4 XE L
> 2 E 2 T subckt Block04 123 4
BLOCKDS BLOCKOG | B .ends Block04
# : 9 e BLOCKAT t
1A subckt Block0512345
.ends Block05
1 5 i &
] .subckt Block06 123456
P | . 1 .ends Block06
el BLOCKDa # fa i i
.subckt Block07 1234567
i ) B | .ends Block07
15 P
PRt subckt Block08 12345678
th i» .ends Block08
i i | subckt Block1412345678910111213 14
.ends Block14
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Part 2C
Symbol for Subckt
[Link to Library]

Symbol for Subckt [Create Symbol and Link to Library]

Himss0ib & |
1 Preb 16, 2010
Example to create subckt symbol for irf530 *Doc. ID: 90181, Rev. A
[1] File > New - New Symbol ;T ° e Dase AXCoS0 B UKL and DAt Aet
[2] Right Click = Pin (to add 3 pins with order D, G, S) | e et i S i
[3] Right Click at center of Pin to review PinOrder and PinLabel K Arprapriate dara Shosf of ‘the sams nimber

*limits.
: .SUBCKT irf530 1 2 3
3 S S S S S S S SRR RS E SRR R R R R SRR SRR TSR
|:| i * Model Generated by MODPEX *
s .
PinOrder »

11 *Copyright (c) Symmetry Design Systems*

All Rights Reserved *

e e EditPin‘Label * UNPUBLISHED LICENSED SOFTWARE  *

3 nvert OverBar * Contains Proprietary Information *

Al invert Case 15 * Wwhich is The Property of *

Font Size » % SYMMETRY OR ITS5 LICENSORS *

[:I Orientation *Commercial Use or Resale Restricted *
® color 18 * by Symmetry License Agreement L

G LR RS S SR SR RS RS R R E RS E R R R R R R R EEE S

v b * Model generated on Rpr 24, %6
* Model format: SPICE3
* Symmetry POWER MOS Model (Version 1.0)
1 D 2 * External Node Designations
* Node 1 -> Drain
2 * Node 2 -> Gate

£ * Node 3 -> Source

7 Ml 97 8 8 MM L=100u W=100u
* Default wvalues used in MM:
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Symbol for Subckt [Create Symbol and Link to Library]

[4] Draw a box for outline
[5] Put an “X" in Symbol Type in Symbol Properties
[6] Right Click - Text > Put an “X"

Symibol Properties
Application
~1 s Al @
LI tins. b Ll F
Basics
Symbal Type X
1 Descripian
AllowShorted .. False
Library Fil
[“1 | | | | String Aftributes
- | | Ap— ‘1&"“0 X
i Mats
i i N aue : 7T D
- 2 Pin name appeared
= Box Cri+B 5 pp
__._._D_m Cail after step [6]
= Eliipse E
== Line Ct
O Pin ]
a Text Ctris
<y inangie =t

[7] To justify Pin label, double click center of Pin
[8] Click red dot other than its centered justification
[9] Save symbol file as .qsym

[2] e.g. click here
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Symbol for Subckt [Create Symbol and Link to Library]

[10] In Schematic, Symbol & IP Browser, Right Click to
“Add a symbol directory”
[11] Drag created component to schematic

@ QsPICE™ - Untitled
File Edit View Help
JSd 08 fe@

Symbol & IP Browser w X

- aufni:'-"
+ [ Behay
= Qorvg
- JFE

I_.Siﬁ
+H-5 Si
|

Add a symbaol directory

iNatve Deevice

D
SX1

o

2057 Machine gesesa
ookt

[12] Right Click on symbol, “Add New Attribute” as irf530
[13] In Symbol Properties, add “Library File" as irf530.lib
** library file is required to be put in schematic directory

N‘lﬂllcdlonn“
D (+\V2 Sbl A g
G X1 =) x
7 5“ S firfs30 710 ras
0 e

G

(

71 Add New Attribute
Orientation
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Part 2D
Convert MOSFET M to
subckt Symbol

41




Convert MOSFET M to subckt Symbol
Qspice : Call Lib from M.gsch

M1 .
drain

- NMOS
It is possible to convert MOSFET symbol M
into a sub-circuit symbol by
1. Change Symbol Type from MN to X
Library File as subckt library file

2
3. Tstattribute as subckt name
4 [Optional] Change Symbol Name to X?

gate Al

irf530

0 e

:;Ds .dcvg050.1

** this alternative symbol is 4 pins [+ base),

Symbol Properties - X
Application
1 e
—| Basics
Desciptan M-Cheanfral MOSF .

Allow Shorted .. False

Vd Library Fik =50

Siring Amibule

peli 20 1bies
Name: x
PinName Invis Net

drain
G gale
5 GND

which cannot support 3 pin subckt
Pin Order in Symbol MN and MP
Pin Order for Symbol MN (NMOS) Pin Order for Symbol MP (PMOS)
Application v Application v
FRARER 2l M
draln - ::r::::c:Type MM SOUFCE3 I 2:::oslType MP

Dascription N-Channeal MOSF. 2
Allow Shorted ... False
tlbrary File NMOS tet
= [rmg Alinbules [=

Text Order Invis ntent 2 Text Ord
Name M!

gate 1st attribute NMOS gate i

N MOS Pin Nets PMOS [zl Pin Nets

1

Description P-Channel MOSF...
Allow Shorted .. False
Library File PMOS ixt
= Siring f\!tnbule*‘
= er InVIs, tent
Name: M2
st atiribute PMOS

lame Invis. Nat

D 1

D
source G 2 drain p 2
s 3 5 7,
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Part 2E
Bus and Hierarchical
Block




Bus and Hierarchical Block

e Bus and Hierarchical Block
e With Bus, data is defined as Data[n:m]

* In Qspice, this net name format create a series of net names from Data[n] to Data[m]
e Ifn<m, net name are Data[n], Data[n+1], Data[n+2], ..., Data[m]
* If n>m, net name are Data[n], Data[n-1], Data[n-2], ..., Data[m]

* For hierarchical block, subckt bus net names are assigned according to index sequence

* To use data bus, it is recommending bus, hierarchical block and subckt with same data bus
index, which can prevent unexpected behavior in net assignment
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Bus and Hierarchical Block

Qspice : Parent-BUS.qgsch / BUS_Hierarchical.gsch / bus_dll.cpp

[1] BUS is equivalent to create

(1] multiple net names with ]
J—"Z Aln:m] creates A[n], A[n+1], ... Alm]
oy,

X1
P
—{n  do:) a3} o o
@l al ot
d00115 Portand Data Type a2
o i inpE, w L L ald =l
al H s i

ran 1
plot Wol} Wol)+1.1 Wo2+2.2 Vo333

Jplot WATOT) VIATLT 1.1 WAZTH-2.2 WA[STH33
plot Win)

W¥in

=
o 1]
& 5

¥ C:\QspiceKSK=lwviniDl User Guide and ScriptiDl (=pice Referxence (
@Rl «in wiw «&[0] b &[1] b A[2] b A[3] bw «» BUS _DLL

V1l in O 0115

X2 A[O] 1] Al2) AI3) =0 =l o2 o3 BUS Hiezarchical

. subckt BUS H:_Wdrn] d[l] 4[2] 4[3] aD al aZ a3
VL 4[0] aff @
[2] Subckt X1, hierarchical X2 are all

V2 d[l] al @
V3 d[2] a2 D X
feed in same name and order

Vi d[3] a3 D
-=nds BUS Hierarchical

-tran 1
-plat
-plat
-plat
-end

Vi{ab) V{ol)+l.1 V{o2)+2.2 V{o3)+3.3
VIA[D]) W{A[L])+1.1 V{A[2])+2.2 V{A[3])+3.3
V{in)
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Bus and Hierarchical Block : Change BUS name order
Qspice : Parent-BUS.qgsch / BUS_Hierarchical.gsch / bus_dll.cpp

woj [1] Reverse BUS index is equivalent
#1] to create multiple net names with []
I Alm:n] creates A[m], A[m-1], ... A[n]

—n d[iia] 2 df0:3] oo
@:\ i al ot
d ot and Data Typ

Al

5 a2 —d
00115 ¥2 -
B e
tran 1
plot Wol) Viel]+1.1 WelH2.2 Wa3)+3.3
plot WALOT) ViALL])+1.1 WALZT+2.2 WA[3])=13
pot 'Win]
4 Wi
dji P! iI
o
&—=
o !
o
& {c]

¥ C:\Q=picek Lorha il Usey Guids Seripti0l Qspice Reference {
@Rl win uiw «A[3]'b A[2] b A[1] b A[0] bef «» BUS DLL

VL in 0 pwl 00 L}
*2(A[3]1 A[2] A[1] A[0]) a0 ol o2 oJ BUS Hierarchical

-subckt BUS Hierarchical 4[0] 4[1] 4[2] 4[3] ol ol o2 a3

VL d[D0] a0 ©

vz cl[[:].} ol 0 [2] Subckt X1-d[0] is connected to A[3]
V3 d[2] <2 O . g . . .

va afa] == [3] This order is feec_i into hierarchical block
.=nds BUS Hi=rarchical X2, (SHek A[3] is feed into X2-d[0]

.txan 1

.plat V{aD) W{al)+l.l W{a2)+2.2 V{a3)+3.3

.plat VI{A[D]) W{A[L])+1.1 V{A[2])+2.2 V{A[3])+3.3

.plat V{im)

end
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Bus and Hierarchical Block : Change Hierarchical net label order
Qspice : Parent-BUS.gsch / BUS_Hierarchical.gsch / bus_dll.cpp

. . . . ¥ C:\QspiceKSK=lwviniDl User Guide and ScriptiDl (=pice Referxence (
‘01 [1] Reverse index of hierarchical @Rl «in uiw «&[0] b &[1] b A[2] b A[3] bw «» BUS_DLL
f1] name label Wl in D pwl D D 1 15
2] X2 A[D] _BALY REZ2] AL3) 90 9l of o3 BUS Hierarchical
X o .subckt BUS Hierarchicai¥a[3] a[2] 2117 2[0])c0 ol a2 a3
- — \d V1 d[0] =0 T - > = .
" d[0:3] P ] e w2 d[l] ol 1 [2] Hierarchical block X2 name is reversed,
¥1 ' i V3 d[2] «2 D : : B )
@“ :2 it va af3] o3 © but Hierarchical / Subckt net assignment is
4 ¥2 =, i .ends BUS Hierarchical based on order, therefore, A[0] is feed to
B e 5 i 8 i i
Frand e e e A hierarachical subckt d[3] in this case
; x .plat V{aD) W{al)+l.l W{a2)+2.2 V{a3)+3.3
ot Vol Vel 1+1.1 Wed 2.2 V[a3)+3.3 .plat VIA[D]) V{A[1])+1.1 W{A[2])+2.2 V{A[3])+3.3
ot WATOT) VIATE])+ 1.1 WAT2TH2.2 WA[3])+3 3 _plat V{in)
plot Win) _=nd
= V1D
o
]
G {o3
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Part 2F
Device with .model

Device with .model
Qspice : Diode - .model and embedded .model.gsch

Symbal Properties

® DeVICG W|th .mOdeI Diode with Embedded .model Application
In Symbol Properties Rl 3.4
e .model can be added Library File : Add .model with | at beginning = & 1, 5
with a text in schematic Pt o </_|/L R —
e For embedded .model, Moo _— =
the symbol “|" need to
. . .model Dmdl D Vfwd=0 Vrev=5 Ron=1m Roff=10=6 Pin Nata
be added at beginning dc V1 -6 1 0,01 e o
H plot I(D2) " aNo
of .model in Symbol PRt 1D1)

Properties > Library File

+ Without symbol “|", lib will
be used in netlist to look
for a library file name in
this field

Netlist

W1l w0100

Mmedel D2sDmdlEmbs D Viwd=(0 vrev=E Ron=lm Reff=10s&
D2 W01 0 D2+DmdlEmb

Dl N0l 0 Dmdl

.de vl -6 1 0.01

.plot I(D2}

.plot T(D1}

medel Dmdl D Viwd=0 Vrew=5 Ren=1m Reoff=10ef

.lib C:\PROGRA~1%QSPICE\Diode.txt

cend
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Schematic Viewer

Selection Guide for Qspice symbols and library files

1. Assume user has a user-supplied library 3. Place Qspice symbol to schematic
files in C:\QspiceLib * Place Qspice symbol, replace Library File name with
user-supplied library name
‘ C\Qspicelib|  [1] Library file directory Symbol & 1P Browser  w X Symbol Properties .
5 Ja Application
Name This mos library from 0. I-Current Soun ~ M1 Sa3
’ bordodynov.ltwiki.org/standard.mos.XVIL.txt j:: i o
& standard.mosXVil e 2w n"I Bacrpion N Channsl MOSFET Tra
% M-Channel Allow Shoried Pins False
. . ; B o’ NMOS el RS
2. In .Qspl.ce - View > SymbOI & IP Browser In this example, replace NMOS.txt to
* Right click "Symbols & IP", Add a symbol directory standard.mos.XVIl.txt
+ Add C:\Qspicelib S 4. Selection Guide
@@;] M1 il o
L .-{ T Acd New Attribute »: ?}:
When add a symbol directory, . ’ o
it will add following in netlist e @ Peinet HelgFie Page " -
Jibpath "C:\Qspicelib" =————p=2 seocs S Do Mot Sttt

** If a path without .qsym, it will not show in Symbols & IP browser. But the path
can still be added. Right Click > Edit User-Supplied Directories will shown that
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Selection Guide for user-supplied symbols and library files

1. Assume user has a user-supplied symbols 3. Drag user symbol to schematic
and |ibrary files in C:\QspiceLib * Right click on symbol, “Selection Guide" is available
| oA o Symbol Properties Symbol & IF Browser bt

AQspiceli T

Application

= Dl D1

Lol Basics

@uset_diode-asym ;\:::..’DuLim g...m.. Dicda T Add New Attrizte

& user_diodetxt D B o i Ul ;J::wu:.:;mwﬁ v
[1] Symbol and Library [2] Library File in user symbol is .
in same directory library name (e.g. user_diode.txt)

2. In Qspice : View > Symbol & IP Browser

Right click “Symbols & IP", Add a symbol directory
Add C\QspiceLib

[Syrmboi & Bromser

-

When add a symbol directory,
it will add following in netlist

e
ey

ool LMD B . 1 P
\ptreD e Ersimatoral Recttar fipe

14 Cope§Ep M M ] By 68 10e] w5

Cehatiy

o I

—

kskelvin.net

54



Eliminate the use of absolute path in user-symbols

1. Assume user has a user-supplied symbols
and library files in C:\QspiceLib

Symbol Broperties

D1 Application
B 2l3 s

= Basics

| C\Qspicelib

Name
Symbod Type o
Description Silicon Dicda
Allow Shoded Ping Faize

@ user_diode.gsym
& user_diode.txt

D

[2] Library File in user symbol is
library name (Not absolute path)

[1] Symbol and Library
in same directory

In Qspice : View > Symbol & IP Browser
* Right click “Symbols & IP", Add a symbol directory
* Add C\Qspicelib Syt B ¥

When add a symbol directory,
it will add following in netlist
Jibpath "C:\QspiceLib" >

3. Draw a schematic in other folder
. Now you can use user-symbol or Qspice symbol but
change library file from diode.txt to user_diode.txt

e _ode.gsh

ST ey

|t & B w

[Comear | By D1 D2
o 50 1N4148 | 1N4148

.dc V101001
.plot I(D1) I(D2)

@ Qorvo QSPICE™ - Testuser_diode cir = o b4
File Edit View Help
[N . "y
* C:\KSKelvinQspice\0l User Guide and Script\02 Gen

-libpath "C:\QspicelLib" | Qspice search path for files

1. If specified as an absolute path, only that is used.
2. Current working directory

3. Directories supplied in .libpath command(s)

4. QSPICE installation directory

V1 NO1 OO

D1 NO1 0 1N4148
.da V1l 01 0.01
.plot I(D1)

.1lib user_ dicde.txt
.end
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Waveform Viewer Plot Config File (*.pfg) and .plot directive

» Waveform Viewer Config File (*.pfg)

and .plot

* In waveform viewer, plot config can be saved with File > Save Config : [gschname].pfg
* This config file save windows, traces and axis setting
+ Press spacebar in waveform viewer can re-load config file [gschname].pfg

» Two unique feature [gschname].pfg can provide but not support by .plot

+ Pre-define x-axis Quantity
* Pre-define x and y-axis range

Waveform Viewer Plot Config File [1] .p.lot comma_nd Outcome
[aschname].pfg in schematic
No No A blank waveform viewer
Closed before Simulation No Yes Plot according to .plot command
Yes [ignore] Plot according to [gschname].pfg config
Opened before Simulation [ignore] [ignore] Keep windows and traces setting from last plot, reset x and y-axis

[1] Save plot config in Waveform Viewer : File > Save Config

** In Waveform Viewer, press Spacebar to reload [gschname].pfg plot config file
** to use .plot, delete [gschname].pfg and close waveform viewer before run of simulation
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Data Export in Waveform Viewer — with @ in expression for .step
Qspice : waveform - with @ for step.qsch

sin » Data Export  Data Export with @
Vi
sin 0 1 fsin . Settljp Data Export . SettIJp Data Export
o * File > Export Data * File > Export Data
.step param fsin list(40G][80G + Number Points : All + Number Points : All
Aran 11,-'f_5||-| « Expression(s) : + Expression(s) :
.plot V(sin) V(sin),FSIN V(sin)@1,V(sin)@2

22, 1332320000
FTIEL L3322
-

1023333333332
SE, 430323333

=

33335, 3333237392
BEED MR EPR R D DR DD
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Snapshot Data Method - Export Data with Single Number Points

Qspice : waveform - time snapshot.qgsch

« Snapshot Data e | i
» To create a snapshot dataset ,-\Ff,l\( _ :”m : == Wn p -
(e.g. all calculated results at 1K J_ S e e e et
particular time) Vi C1 R2 — S SA—
* This example d.emonstrate a 1 Ilp 10K
snapshot data in csv format

with export data method
* |dea is to force number

points in data export to 1

+  Output two row but both are
identical if start and stop are
same

» |If start and stop are not same,
output two row with time=start
and time=stop

tran 10m uic

In waveform viewer

File > Export Data

Change Number Points to 1
File Format : CSV

Abscissa Extent : 1, Start = Stop
Select All Select A1 Cancel ]

Expresmon(s): | MREZ)LV{n01),VL)ECL) ¥R2)JR1)

uhwn =

S —
Result in exported csv

LUGOHAS Bk O (L0
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Data export in .ac analysis — Complex format
Qspice : waveform - complex format (.ac).qsch

+ Data export in .ac analysis
» Data export in waveform viewer from .ac analysis is complex format
* In.graw data file, Flags : complex
* Complex format data in ascii (.csv) is as R,X
* where Ris real and X is imaginary
+ If assume data is complex voltage Veompiex = Vi + jVs

|Vcomplex| =4 Vrz + sz = abS(Vcomplex) dB @ 100Hz
- Magnitude In dB : Veompiex.as = 2010810|Veompiex| = 20 * loglO(abs(Vcomplex))

LV eomplex = tan‘l%‘ = atan2d(imag(Veompiex ) real(Veompiex)) = angle(Veompiex) * 180/pi Phase @ 100Hz
in I I out o 4 §43254
1 )
V1 1y R1 !
AC 1 " T T T
wr @100Hz, V(out) = 0.28304 + j*0.45048

.ac dec 100 1 1e4
.plot V(out)
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Waveform Viewer — Minimum Tick and Waveform Measure

e Minimum Tick

e Maximum number of ticks in : _ " | Maximum number of ticks
x- and y-axis are 11 il #¥9 reduced to 6 after reduce of
+ Depends on windows size, ; - v windows size
maximum number of ticks can i
reduce to 6

e Therefore, minimum allowable
. . Right—Left top—bottom
tick is —2 or 22

10 10

* Waveform Measure
+ Ctrl + Right Click on plot
label

° 7-types of measurement
*  Average
Maximum
Minimum
Peak-to-Peak
RMS
AC_RMS : remove DC
Integrate
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Waveform Viewer — Linear Scale in .AC, Polar vs Cartesian

* Linear Scale in .ac e

* Right Click on Y-axis

* In Axis Setup, de-select
both Log and dB

* In Polar representation,
left y-axis is magnitude
which represent value is
always apbsolute (no
negative value)

* Polar vs Cartesian

+  Waveform viewer default
representation of .ac is Polar
representation (mag,phase)

* Right Click on Y-axis to
change to Cartesian
representation (real,imag)

+ Polar is normally for bode
plot and cartesian is for
iImpedance plot
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Waveform Viewer — Plot Reflection Coefficient (I)
Qspice : waveform - cartesian (Gamma).qgsch

* Impedance Trajectory

L1
. I -
« .ac analysis can be used (éw Ji;z 23.48n %“

to calculate impedance Z ac1 J1s1sn 3
or reflection coefficient ac dec 100 1Meg 100Meg

77,
T Z+Zo ; Calculate Reflection Coefficient
. i Sunc Z0) Viin)-Tiv1)
Trfajectory C.an be pIOt Sfunc gamma() (Z()-50)/(Z()+50) -
with Cartesian plot by plot gamma) g TR

setting x-axis to plot real

part and y-axis to plot

imaginary part

* Right-axis : Cartesian

+ Left-axis : No Real Plot

+ X-axis : Quantity changed
to Re(<var>)
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Waveform Viewer — Suspend Cross Probing

» Suspend cross probing

» After running a simulation, a !
probes are automatically @ Rerun simulation F5
added to the waveform o Drawa Wire w
viewer when clicking on a V1 Rl < Place Ground G
node or over a device. NT  Place a Net Name N
However, this can @ Place Text(SPICE directive) T
inadvertently disrupt the 1 1 &L Place a Bus Tap
waveform setup Draw Graphical Annotation »
» To address this, you have b 2 Show Grid Ctri+G
the option to suspend 2 Mark Text Anchor Points
CrOSS‘prObing. In the R Hide Reference Designators
SC.hematIC WlndOW, rlght_ 411 Draw Hierarchical Entry Ctrl+H
click and enable "Suspend | —————
Cross-Probing" (this option 1 '
will only appear after B Ydo Ctri+Z
running a simulation and tl'an 1 Redo Ctrl+Y
with an active waveform & Copy Bitmap to Clipboard
window that has cross-
probing to the schematic)
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Probe .subckt or hierarchy voltage and current
Qspice : waveform - probe subckt.qsch

* Probe .subckt or hierarchy voltage and current
 In default, Qspice only returns parent schematic voltage and current expression
* However, if you open a .qraw data file, you can observe that the voltage and current expressions
for .subckt or hierarchical components are stored, such as in the format V(1<x1)
* In the waveform viewer, right-click > add plot > "Asterisk Matches Hierarchy Separator” to
enable probing into subckt or hierarchical components

R R R R R IR FE S R S R SR R R SRR o 3 " @ Compose Expresion to Piot
=M. EMIOE IT pimest: 0G5 @ Qorvo QSPICE™ - waveform - probe subckt.qraw %

*Coppeght {£] 1958 MuroCoda Engirsrie, e : kst

a5 gl Rabirvad e File Edit View Help - :

BN R,

f+ | Zoom to Fit

For example, symbol X1 calls to
use .subckt XIRF740

o B - 7 Ab a Extent
To probe M1 node “1” in X1, it St
; B Add Pt cxiin
Is V(1x1) 3 A Wit Cirf+ W
e & 1 Select "Asterisk
| - Matches Hierarchy
=% Show Grid Ctri+G "
Separator
= FFT
= THET Raer) VRLAE=BIAE BT 1 VT 0n 3 Chuet B8 s Copy Bitmap to Clipboard
= b W Rl T
5 RS 12 B OO =90 Vied Wed] TT=10) Rerun Simulation PreRmO =
EMEE: RFa it fomlor e ]
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Symbol Viewer




Attribute with Angle Brackets <

>

» Attribute with

brackets
e The 1st attribute of a
symbol is its name, and

X1
S

[

* Symbol Viewer
mbol -

]

starting from the 2nd

-

attribute are the instance
parameters

When angle brackets (<
>) are used for instance
parameters, they can
restrict the user-editable
section of the text
attribute

Each attribute only allows
for one bracket; any text
after the bracket is ignored

=

2 .. ..

X1
Symbol

.a

——
oy —

1.
2' Without Bracket

- -

Simulation Technique

Max Time Step in .tran (and .bode) : Two methods

Qspice : MaxTimeStep.qgsch

V1G
Q.
Lsin011G

Method 1 : Traditional Berkeley Syntax
fran IGNORED TSTOP [TSTART [MAXSTEP]] [UIC]
tran 0 10n 0 10p

t Max Time Step

plot V(V1G)

Method 2 : MAXSTEP in Simulator Option
tran 10n
.options MAXSTEP=10p

Max Time Step
(this method apply to .tran and .bode)

** Qspice uses adaptive step
size algorithms, each time

| step can less than maximum
time step size
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Add [additional instance parameters]

Inductor Instance Parameters

1.

Right Click on Component

Y A W Name Description Units Default
2. Select “Add New Attribute AG wire or stripline is made of gald
3. Type parameter name and value [refer to help for full list of AL Wire or stripline is made of aluminum see belaw
instance parameters] AU Wire or stripline is made of silver
BEND Fractional inductance carrection for wire bend or "
proximity effects .
CPAR Parallel capacitance F 0.
This is an example to assign 0.2 ohms series resistance to inductor L1 £ ielorsirplinelismadeloficoppen ee|beiow
DIAMETER Diameter of wire or air coil m
L 1 Symb&:.\l Prr:merhes FREQUENCY Frequency at Q. Alsnsaf.e:ﬁ?cfnmpube Rser due to
App!lcailon HEIGHT Height af PCE stripline above ground plane m
m\‘ . Fn: A l _.l £ Ic Initial current if uic is specified on _tran statement A none
| b N INDUCTANCE Inductance of inductor H 0.0
Basics Current causing inductance to drap ta ;
4 Symbol Type L Y SATFRAC=INDUCTANCE . finte
D-escnpnon Inductor LENGTH Length of wire, stripline, or air coil m —
% Pertinent Help File Page Allow Shorted .. False LSAT Inductance asymptotically approached in saturation | H INDIL?LL?'ANCE
7} Do Mot Stuff Library File M Number of parallel inductars 1.0
; = String Attributes NI Wire is made of nickel
2 Stuff with Jumper Text Order Invis. Conten Q Quality factar at FREQUENCY
[E Standard Value Nama: L1 RPAR Equivalent parallel resistance Q Infinite
= | 1 h = RSER Equivalent series resistance Q 0.0
statnbute s SATFRAC Fractional drop in inductance at ISAT 07
THICK Thickness of stripline on top of 8 PCB m 0.0
TURNS Number of turns of an air coil
WERBOSE Print wire L, Rser, Rpar results on the console (not sat)
WIDTH Width of stripline on top of a PCB m
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AC and DC Attribute in Source
Qspice : AC with Transient Source.qsch ; AC with Bias.qsch
Technique to perform AC analysis with a transient source Technique to perform AC analysis with DC in source
1. Right Click on Voltage/Current source 1. Right Click on Voltage/Current Sourec, Add New Attribute
2 Select “Add New Attribute” 2. Toadd DC source, type “DC ..."
3. Type "AC 1" to define a 1V source for AC sweep + If without DC, simulator may not interpret the DC voltage
4 Add a .ac analysis statement, and comment transient analysis during simulation. Best practice is to add DC
Symbal Properties -
Application a r'| Dd E‘
AN | l
Vi Basics V1 D1
Symbol Type  V
e Description Independent Vol
Allow Shorted . False
sin 0 1 1K Ly Pl ! AC1 1N4148
(R rser 0 2 Sir |T|-.| .-'\..'ml_-uln.--. — | I
: AC 1 Name Vi _D_g_t_”_a_si
“““ Tt attribute sn 011K
tran {10/1K i el .ac list 1K
Ll B L1 S e step param bias 0.3 0.8 0.01
' . o0 .plot ac I(D1)
kskelvin.net 7
Laplace Time and Frequency Domain Simulation
Qspice : Laplace Simulation - Fdomain.gsch ; Laplace Simulation - Tdomain.qsch
2nd-arder sysberm step responss
Eransfer function - omega®2/[£* 2+ 2% mtaamega+omega™ 1)
.param zeta = (0.7 tran {eT}
param omega = 1 ‘param eT=25
—Output]
~F 4th-arder transfer function with mukiple of twa 2nd-order TF
Tlaplace = i amaga,Teta T cmaga,zata)
" func tomega zeta) omega®*2/[5**2+ 2 zeta* cmega®s +amega® * 2]
Input | T :
INT T Standard 2rd-order transfer furction
I.aplarr = omaga** /s * 2+ 2 atatomega s+omaga )
pulse 01 u-:u..:rp{ﬂ Time Domain
Frequency Domain
Input Output
El
L Vi =
ac 1| ] Laplace = (s+100)/((s+1)*(s+10))
ac dec 100 {1e-2/2/pi} {1e4/2/pi}
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Laplace Time and Frequency Domain Simulation

Qspice : Laplace Close Loop.gsch

Close Loop System Time and Bode
* A technique to get Gp(s) and GH(s) is to
add a perturbing source between output
and feedback and perform ac analysis
In this example, Laplace function can
collect in series for both .tran and .ac
directive

I'M Tl |'.'| ]
Hant

.ac dec 100 1e-2 1e3
plat s Wenrpit el

fran 10 wic
ot tran Wref) Woutput)

5 ot e Vet VL
E3 - Different el
Vi : Relerencs
V2 Perturhing Source
_--l.-':'l._ it T E" i
e, ol | ok 5 Laplace=1fs 7 Laplace=w"™ ZI e L A T
= = e param v ]
‘param a2/
| L
|'.-_ i
AC1
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AC (.ac) and Frequency Response Analysis (.bode)

Qspice : ACmethod.qsch ; BODEmethod.qgsch

Different Plant
el i
N S o
AT &)
b=t 1 T Laplace=1/{s+1}
Ll & —;r o ;
V2
i
ol
AC1

Jgran 0 100 wic

ac dec 100 le-2 100 .plot ac VWout)/V{fb)

Different Plant
e Ot
o LED A-EL
) ly } T
|\+/!l l-.._..-1 _A']'/LEDIE‘CE:]-'.I[E"_J-.:I
> w~ pr i
V2
i '\I
)
0

Jdran 0 10 0 uic
bode V2 10 1e-2 100

OpenlLoopGain

** GH(s)=-V(out)/V(fb)

** GH(s)=-OpenLoopGain
-20dB—

-40dBE—
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Technique to Probe NMOS Drain Current / General Current Probe

Qspice : Current Probe Method.gsch

* Current probe method

Method #1 : Resistor

Add a series resistor (small
value) and probe R current
I\/Iethod #2 : OV Voltage
Add OV voltage source and
probe current of this voltage
source.

+Vve represent current flow
from + to — direction within
symbol (i.e. +ve current
represent current flow
downward in this example)
Hold SHIFT key in Qspice to
probe voltage source current
can give default +ve current,
otherwise it will assign —ve to
current )

Method #3 : Probing

Probe current by hover point at
device terminal

» Not support sub-circuit yet
OR Ctrl-A (Add Plot) in
waveform viewer and select
[d(Mnnn)

Rl

im
draini

3'1’

"37214 7002 L

dev2D501

i
\E/n
Mdrain2
L1
2Nm02 T10

el 1
24-— Hover for current probe
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Technique to Probe NMOS Drain Current / General Current Probe

Qspice : Current Probe with Resistor - Limitation

e Limitation in R current

* If sensing resistor with Vi R1
extremely small value ¥
compares to its sin 01 1K in
measurement object,
current reading from this R2
resistor will be incorrect

+ Use 0V voltage source tran 1/1K 100K
approach as replacement .plot I(R1) I(R2)

* Explanation — by frank.widmann in Qspice forum
* https://forum.qgorvo.com/t/persistent-bug-warning-sinqular-matrix-check-node-b/17636/21

frank.wiedmann

Here is the explanation for the behavior observed by @KSKelvin : SPICE uses Modified nodal analysis
- Wikipedia which directly calculates the node voltages and the currents through voltage sources. The
current through the small resistor, on the other hand, is calculated indirectly by dividing the voltage
difference between its terminals by its resistance. With a resistance of 1u, the tolerances of the voltages
are almost as large as the voltage difference, causing the observed imprecise results.
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B-Source as Comparator
Qspice : B-Source as Comparator.qsch

» Concept of Ideal Comparator with Behavioral Voltage Source
* Formula of B-source is : if(V(pos)>V(neg),V(Vdd),V(Vss))
* Practical comparator output normally is open-drain configuration, this is just for simulation
purpose

"...-'_‘ir.lLr] 1“.‘_-.}"."2 tran 1/Fsgl
@5 @5 plot W{out)
-plot V{pos) Vineg)

pos ’“"“{r
@UE.mram Fegl=10K @4 param Few=100K

sin 0.5 0.3 Fsgl pulse 0 1 0 0.5/Fsw 0.5/Fsw 0 1/Fsw

ol |
;iﬂf{'ﬁ pas)=W{neg), W [Vdd), VVes))

| B-source as Ideal Comparator :
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Monte Carlo
Qspice : Monte Carlo.gsch

Random number from 0 to 1 depending on the seed

/Lv1 R1
= /]_

?7 1K*(1+.1%{random()})
This. example .1*{random()}
-Op equivalent +0% to +10% change

.step param dummy 0 100 1
.plot I(R1)

. This enable random seed to
.options seedclock «— be generated
.Options SEEd -_—5 <— This assign manual seed

@ 742023
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Flat(x) and MC(x,y) functions equivalent to Ltspice
Qspice : Flat and MC Function.gsch

* Uniform random distribution
+ LTspice offers flat(x) and mc(x,y) functions, but not in Qspice (last check 10-3-2023)

* Function for flat(x) and mc(x,y)
+ func flat(x) x ((random()*2) 1) «=—————Generate random [-x, X]
+ func mc(xy) x*(1+y*(random()*2-1)} «=————Generate random [x*(1-y),

X*(1+y)]

plot Vime)
:gt;p param x 1 200 1 Dummy For Loop plat V{Flat)

.plot V(random)
random

1.,.'3
randcn'n[} fIa‘l‘(lD} n'H:LlEII 0.1)

flat(x) : Random number between -x and x with uniform distribution
func flat{x) x*((random()*2)-1)

melx,y) : A random number between
x*(1+y) and x*(1-v) with uniform distribution
func melxy) x*(1+y*{random()*2-1})

kskelvin.net 79

Time in .tran and Logic Diagram in Waveform Viewer with .plot
Qspice : Time in .tran.qgsch ; Logic Signal Plot.gsch

Time in .tran _ etime
* |n .tran, simulation time is 1

stored as a parameter .
i"’vzﬂme

named Time
+ Therefore, use a B-source

dran 1 .func runtime() Time
plot V(etime)

can convert Time into a
voltage .
« Time can also be used in
function .
plot runtime()

* Logic Diagram
» A simple idea to plot logic
signal into logic diagram

i peict)

If':"I.I.JI.Je 100 0005 14F C;}LLJEE 100000 054 1144
farmat e i

+ ldeais to add an offset for “Eoulse 10 00 005P2 Y2 Epulse 10000 055 L8
each logic in .plot

param F=1
Aran Lif*16
Splot VBT -+ 3.3 WERI |+ 2 7 WHBEL )+ 1.1 WED)
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Dummy TTOL device to help in adaptive timestep
Qspice : TTOL - Dummy TTOL element - Enhance Timestep.gsch

* Dummy TTOL device i, Elapsed time:0.328777 Ly
» Qspice uses adaptive timestep (e 05 0.4 tompioeon <1
» If a circuit uses a B-source, b P ﬂ:L_lc L el
if(x,y,z) as a comparator, without ,Li.e ."‘“.5' vw:s'iﬁ:-

TTOL device, its simulation “Timobae 1110 5o Sifow 01 Lifiay
timestep can far from compare paam o LK

'U‘l' FWlay=Vlhj, 19,0}

|nstance and output looks weird
Example on Top Row
Precise time instance at compare
action, but as no extra timestep after
compare action, output looks like
ramping as next timestep is far away
(interpolation)

» To resolve this without using
MAXSTEP to limit timestep, a
dummy TTOL device can be used
(e.g. Switch), with TTOL instance
parameters included

Example on Bottom Row

Extra time steps are added after
V(compare) flip the switch, with
additional time steps, output looks
reasonable

Smaller TTOL value can yield a better
results but with longer elapsed time

Aran L0000 5w
.plat Woompare]
— .pat Wh] Wa)
pare— Enabie Disabic: with
« D Ao Soull

[ Right Chck
- -

-’1\"' Elapsed time : 0.788397 {l,n.
L)

ok 0.5 04 Fom 10000 ;
pl 5

- : =4
r’J"‘."2 (l?n a S ll"
- - =
‘e 010 Sitow SPW 0300 2 W 10.0]
param Fra §0K

Sriry 10000 Frw
plot Wizompare]
= phot W{h] Wal
T Entable Dinable mith
fat = 4 gl Click = D ot Stulf
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TTOL device to help in adaptive timestep (e.g. function IF)
Qspice : TTOL - TTOL device to Interface Analog and Digital.qsch

TTOL device interface

Qspice uses adaptive timestep

If a circuit uses a B-source,

if(x,y,z) as a comparator,

without TTOL device, its

simulation timestep can far

from compare instance and

output looks weird
Example in Top Figure

*  Precise time instance at compare
action, but as no extra t\mestelo at
compare action, output looks like
trapezoidal as next timestep is far
away

To resolve this without using

MAXSTEP to limit timestep, a

TTOL device can be used (e.g.

buffer with default TTOL=1u)
Example in Bottom Figure

»  Extra time steps are added after

V(cmpA) flip the buffer, with

additional time steps, output looks
square waveform

»  Smaller TTOL value can yield a
better results but with longer
elapsed time

Imerface betwean anakog and digital

0.5 0.4 Faw/ 10000

V(] W B, 10,0

L
Seouise 01 0 505w 5/ow 0 1w
param fow 10K

fran 10000 oy
Jplck Wi cmpa )
ik Wb Wia)

Without TTOL device,
next time step can be
far away

L &

Elapsed time : 0.254715

Inten'ace hetween analag and diga

5 0.5 0,4 Faw 10000

e
Veif{Wa) =0}, 10,0)

X

“Epulse 110 5/Tw 5ifew 0 L/Tw
paraen Faw 108

.I......_.....

stran 10000 =
Jplat VicmpA)
plat Vb) Wa)

[l
L]
. 4 §

Elapsed time : 0.371674
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TTOL device to help in adaptive timestep (e.g. function DELAY)
Qspice : TTOL - TTOL for Pulse Delay.gsch

* TTOL device interface

Pulse source has instance

parameter TimeCtrl to

determine timestep at each

breakpoint (default is

TimeCtrl=Limits), therefore,

extra timestep at its

rising/falling edge

* Example in Top Figure

* But the edge of delayed signal
from behavioral source has no
information of extra timestep is
required, therefore, delayed signal
looks like trapezoid

A buffer with TTOL is used to

improve sharpness of pulse

edge

*  Example in Bottom Figure

« Buffer is triggered when its input
cross REF voltage, with TTOL
instance parameter, extra timestep
is added at such moment

sl Delay with Delay(x,y,z)

@'.-'1

Tpulse 01 0 1n 1n D.5Tsw 1/Tsw
b

1wz
delay (31

ey

\_r)'.-"—:cl:l'.ll"nll': 11, 1/ Fsve/4, 1, Few
& (V{sgl) 1

param faw=1Mag  plat Viidelay)
Aran 100fsw Jplat Visgl)

:E'\ Delay with Delay(x,y,z)
vl + Buffer with TTOL
i’p..-lse 01010 10 05w 1/fw

dy g )
’h?[ 'g TTOL=1/fsw(100 |
I.- deféf’? '1'1‘;&'311?'.‘9#]

param fea=1Meg
Jran 100/ fsw

plat Widelay)
plet Wisgh
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Delay with Transmission Line (alternative way for delay function)
Qspice : Transmission Line for Pulse Delay.qsch

* Delay with Transmission
Line

Beside of delay(x,y,z)
function in behavioral
source, delay can be
generated with transmission
line terminate with Zo
However, this approach may
generate
overshoot/undershoot if
maximum time step is not
defined, this crux is related
to Qspice design as a trade
between simulation time
and accuracy

sl Delay with Transmission Line
Vi

L2

ﬁJuls& 010 1n 1n 0.5/Fsw 1/fsw

” T1  delay
< Z0a50 ¥ RL“

Td=1/faw/4 isn

Jparam fsw=1Meg plot V{delay)
Jtran 100 faw .phot Wisgl)
Joptions maxstep=1/fsw/1000

#'  Delay with Transmission Line
Ifj"l + .options maxstep
pulse 01 0 1n 1n 0.5/Fsw 1/Few
b
54
¥ z0m50 v <RI

Td=1/Few/4 37 50

Tl delay

.param few=1Meg _plot Vi{delay)
Jran 100 fsw -Blat Wisgl
1. 0options maxstep=1/Tsw1000]
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Phasor simulation technique in .ac
Qspice : Phasor - Source.gsch | Phasor - Dependent Source with j.qsch

« Active Source
» Voltage / Current Source
o With formula Az

* Dependent Source
* A dependent source with j to an
active source

() V@) or 1)

i Wn ; !
+3Lmlmua-cmaga

Magnitude
Phase (in degree
- l (in degree)

:

Vn

AC 145
.ac dec 100 1 100
plot V(Vn)
T sl VL)
\3{‘-" 1 ::ﬁlil[‘.-:r. VIR0
Hked stap param freg 1 100 §
{;j:_ 190 :r:rlrhnfeqa-é‘p “freq

Wi Laplace for | part in .ac analyss
In dalieition, &={"omega
Therefore, (WnE = 7*Vn in E1 and Bl

gt-'alvn:- Laplace =s/omega
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Phasor simulation technique in .ac

Qspice : Phasor - jX.gsch

* +jX or—X
* jXand —jX can be
simulate with normalized
inductance and

capacitance
. jXy=jol > L=t
. .1 1
* JXe =P 0=

(I)XC

W1 L1 .step dec param f 0.1 1 100
/ .param omega=2*pi*f
AC L Homegs s listf
plat VZYTCE)
plat WMEZ)TLL)
C1
Ii_-'z.--:-mega
‘JX
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Bussing of Connections and Components — Array

Qspice : Array - LC example.gsch

* Array

+ Arrays can be defined with
square brackets [n:m],
which can be used for bus
connections or
component definitions

* This example
demonstrates using the
array method to replicate
a lumped LC filter network

+ To tap a single node from
a bus, right-click and
place a bus tap on the bus
wire

* Itis recommended for the
user to verify the array
structure from the netlist

L 3 19 b

I :,';,__I.u Ly :';.u 1y :',_lh 1a Ila zi

poo M
1 JLoones] "}ﬂ

g 2

dtran 0 1000 O T00u Ta% we

|_L Place a Bus Tap

.21

Netlist

L1 A[O0] Bl 1p
0 1p
B2 1lp
0 1p
B3 1p
0 1p
B4 1p
0 1p

cl Bl
L2 Bl
c2 B2
L3 B2
c3 B3
L4 B3
c4 B4
Rl B4
L[0]
L[1]
L[2]
L[3]
cro]
cr1]
cr2]
c[3]
R2 A[
vl A[

.tran 0 100p
.plot V(B4) V(A[4])

.end

01
A[0]
A[l]
A[2]
A[3]
A[l]
A[2]
A[3]
A[4]
4] 0
0] o

Afl]
A[2]
A[3]
Af4]
0 1n

0
0 1p
0
1

[y

0 100u/1leb5 uic

kskelvin.net

87



